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Developing and Using Word Electronic Questionnaires at GAO 
 
This guide presents useful practices and tips intended to make gathering information using Word 
Electronic Questionnaires (Word forms) at GAO efficient and effective. This is not official ARM 
guidance, but it should be used with relevant ARM guidance on questionnaire design and data 
collection instrument design. A key step in GAO’s Quality Assurance Framework is to consult 
with ARM or other qualified team experts to discuss data collection strategies, including the 
appropriate software tools, before beginning data collection. 
 
Some images may be copyrighted and may not be distributed outside GAO without consent of the 
copyright holder. 
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Introduction 

This document provides recommendations on developing and using Word Electronic 
Questionnaires (WEQs) at GAO. These questionnaires are used for a variety of purposes, 
including survey instruments completed by non-GAO respondents or by GAO interviewers and 
data collection instruments (DCIs) completed by GAO staff (e.g., when reviewing documents). 
WEQs allow respondents or GAO staff to read instructions and questions in a Microsoft Word 
document saved as a Word form and to answer those questions by entering their responses into 
the document’s “form fields.” Respondents then generally return the completed WEQs through 
email. At GAO, WEQs are distributed as password-protected form files that do not allow 
respondents to change anything other than their responses (i.e., they cannot change instructions, 
questions, response options, or formatting). 
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This document should be consulted to avoid common problems in using WEQs and to speed the 
development of WEQs and the analyses of the resulting data. This document applies to WEQs 
created using stand-alone Microsoft Word 2007 and Word 2010 through the Virtual Desktop 
Initiative (VDI); but should be updated as needed when GAO software changes. This document 
does not directly apply to emailed electronic questionnaires created using other programs (e.g., 
Excel, Adobe Acrobat), however some of the information in this document may be useful for 
those questionnaire formats as well. Although Word can be used to create forms to be printed 
and completed on paper, this document applies to forms completed on the respondent’s computer 
(whether the completed form is emailed or printed and mailed or faxed back to GAO). Therefore, 
recommendations in this document may not be optimal for questionnaires designed to be 
completed on paper. 
 
This document should be used with relevant GAO/ARM guidance on questionnaire design and 
data collection instrument design.   Also, see ARM Guidance for formatting options that are 
helpful primarily for questionnaires that are designed to be printed before a respondent fills them 
out but may also be useful for WEQs.1 
 
As a quick reference, see the checklist of reminders provided in Appendix I.  
 

Background 

While there are several software options to collect data in surveys, WEQs are most useful when: 
 respondents’ email addresses are available;  
 the sample size is relatively small (subjective but roughly less than about 50, due to 

manual processing involved);  
 a format that will maintain visual formatting when printed is required; 
 extracting data from the documents electronically rather than retyping the data manually 

is preferred; and/or the costs and benefits are positive compared to collecting data 
through a web (QPL) survey or a pdf-formatted questionnaire (see Using Fillable PDF 
Forms as a Data Collection Method for details on pdf forms).  

 
This is because 1) WEQs are almost exclusively distributed by email, 2) questionnaires in most 
other formats (e.g., QPL and pdf) generally take more time and effort to develop than WEQs, 3) 
data from WEQs can be extracted electronically using Word macros or other methods, and 4) in 
some cases, the respondent will want to print a questionnaire to distribute it to several other 
people at an organization before responses are consolidated in a single WEQ on a respondent’s 
computer and returned to GAO.  
 

                                                 

 
1 Note that the “checkboxes” and “text boxes” in that document are graphic images rather than functional form fields 
that respondents can use in WEQs. You would need to replace the images with controls so respondents could enter 
responses. 
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Web-based (QPL) questionnaires are better-suited to large sample sizes where the greater 
investment for development is worthwhile. When email addresses are not available, surveys 
conducted by phone, in person, or by mail are the main options, though for interviews WEQs can 
be used by the GAO interviewers to record responses in real-time. For more detailed tips on 
selecting a survey administration mode and the advantages and disadvantages of WEQs 
compared to other survey administration modes, see Choosing a Survey Administration Mode 
participant manual. WEQs can also be completed as “data collection instruments” (DCIs) by 
GAO staff (e.g., for content analysis, literature reviews, or file reviews; see the Guidance for 
Analyst-Administered Data Collection Instruments. 
 

Finding, Inserting, and Modifying the Form Fields/Controls 

Questionnaire designers create WEQs using the Forms features of Microsoft Word. As a Word 
form, when the WEQ is finalized, respondents will be able to provide responses but will not be 
able to make changes to the questions or other text or formatting. The response areas that 
respondents can change are called “form fields” or “controls” in the remainder of this document.2 
These include open-ended text fields for respondents to type in a response, and checkboxes and 
drop-down menus for respondents to select a specific response option presented to them. 
 
This document discusses three types of controls: Word 2007 controls, Word 2010 controls, and 
“legacy” form fields (i.e., Word 2003).3 Additional information about creating forms in Word 
2007 and 2010 is available at Microsoft Word Help Link and more-specifically here. 
 
The controls are located in the “Developer” tab. See Figure 1a/1b. If the Developer tab is not 
visible when you open Word, follow the procedures in Appendix II to display the Developer tab. 
 
Which controls are available depends on which version of Word you are using and whether the 
file you are in is saved as a 2007/2010 “.docx” file or a 2003 (or “Compatibility Mode”) “.doc” 
file (used to ensure users of older Word versions can use a document created in a newer version 
of Word). The “Legacy” fields are available in all Word versions, but some other controls are 
only available in Word 2007 or 2010 (see Figures 1a and 1b).  

                                                 

 
2 Microsoft documentation refers to the “Legacy” fields as “form fields” but refers to the newer equivalent fields as 
“controls.” For readability, this document uses the newer term “controls” to describe both “controls” and “form 
fields” but makes clear when the Legacy controls are specifically being referenced. 
3 Active X controls are also available in Word but are not discussed in this document because they are not 
recommended for use in most GAO WEQS for security and methodological reasons. Active X is disabled by default 
by many users for security reasons, so it is possible that some of your respondents will not be able to use Active X 
controls or they will not be able to without instruction on how to enable Active X features, and may still not be 
willing to accept the security risk. Also, we do not currently know of a method to easily export data from Active X 
controls (e.g., for analysis in Excel). Therefore, although Active X controls offer some useful features that are not 
possible with other Word controls (i.e., radio buttons), you should only use them if you know that all your 
respondents have ActiveX installed and enabled on their computers and you either do not need to export the data or 
you have found a method to export the data. For information on using Active X controls in Word 2010, see 
https://msdn.microsoft.com/en-us/library/office/ff195739(v=office.14).aspx. Please contact ARM’s Survey Group 
for current advice on using Active X. 
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Figure 1a. The Developer Tab in Word 2007 with the controls highlighted. 

 

 
Figure 1b. The Developer Tab in Word 2010 (VDI) with the controls highlighted. 

 

Notice the extra checkbox control available in the Word 2010 controls, circled in red. 

 
The Legacy fields are visible by clicking the “Legacy Tools” icon (the icon just above the “C” in 
“Control”  in the “Controls” section), which brings up a menu choice of “Legacy Forms” and 
”ActiveX Controls.” The Legacy controls are more limited than the 2007/2010 controls but are 
compatible with all versions of Word so are your best choice if you do not know what version of 
Word your respondents will be using. Clicking on a control icon will insert the control into the 
document at your cursor’s current location.  
 
The controls that are useable by the most respondents to questionnaires (and therefore most-
useful to GAO designers for questionnaires) are the three Legacy controls: Text fields, 
checkboxes, and drop-down fields. See Figure 2.  
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Figure 2. Legacy Form Tools with controls indicated 

 
 
Some of the 2007 controls (two text controls and a drop-down control) and the 2010 checkbox 
are variations on the Legacy controls and function similarly to the Legacy versions. The 2007 
“Combo box” and “Date picker” controls could also be useful in GAO questionnaires.4 The 
combo box functions similarly to a drop-down box, but also allows respondents to type in their 
own answer instead of selecting a drop-down option. The date picker allows respondents to 
select a specific date in a format the designer chooses (which would reduce data cleaning time by 
restricting data to a standard date format). 
 
Once you have a control in your document, you can change the properties of that control (i.e., 
adding the drop-down options that you want to be available to your respondents) in one of two 
ways. For 2007/2010 controls, you must click “Design Mode” then click Properties on the 
control you want to modify and make your changes. (Remember to turn off Design Mode by 
clicking it again before distributing the questionnaire.) For Legacy controls, you can change the 
properties by double-clicking in the control or by clicking in the control and then clicking the 
“Properties” button in the “Controls” section.  
 

Choosing Among Use Legacy, Word 2007, or Word 2010 
Controls 

Some controls do not work in some versions of Word, so you will have to choose which controls 
are appropriate based on your questionnaire needs, your respondents’ version of Word, and 
whether/how you plan to extract responses from the WEQs. For reasons described in detail 
below, only the Legacy controls should be used for most WEQs at GAO. See Figure 3 for a 
suggested decision tree to help you decide which controls to use.  
 

                                                 

 
4 The “Picture control” and the “Building block control” are useful for some document templates but of limited 
usefulness for most GAO questionnaires. 
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Figure 3. Suggested Decision Tree for Deciding Which Control Type to Use 
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The Legacy controls will work for all respondents, though they are slightly more limited than the 
newer controls. The Word 2007 controls will allow slightly more functionality than the Legacy 
controls but will not work for any respondents using Word 2003. The Word 2010 checkbox 
control adds no clear advantage over the Legacy checkbox and will not work for any respondents 
using Word 2007 or earlier. 
 
If you know that some respondents will use Word 2003 or if you are unsure what version of 
Word a respondent may use, then you should use only Legacy controls and save the file in 
“compatibility mode” so that all respondents will be able to complete the questionnaire, 
regardless of the version of Word they are using. Only under the following conditions are the 
Word 2007 controls and the Word 2010 checkbox viable options: 
 
You can use Word 2007 controls if:  

Situation 1:  

 NO respondents will be using Word 2003, AND  

 You do NOT want to electronically extract responses from the WEQs, AND 

OR 

Situation 2:  

 NO respondents will be using Word 2003, AND  

 You DO want to electronically extract responses from the WEQs, AND 

 You do NOT need to restrict the type of data that a respondent can enter (e.g., 
restricting the control to accept only digits and not letters), 

 You do NOT need to use any checkbox controls. 
 
Under Situation 1, you can use either Word 2007 controls alone or in combination with 
legacy controls in the same WEQ. However, you cannot use the Word 2010 checkbox if any 
respondents might use Word 2007 because those respondents will not be able to check the 
Word 2010 checkbox. Also, it is not possible to restrict the type of data that a respondent can 
enter in a Word 2007 text control (e.g., you can NOT restrict the control to accept only 
digits) as you can in the Legacy text control. Therefore, if you need to restrict the type of data 
that a respondent can enter in a text field, you must use the Legacy text control, but under 
Situation 1 you can combine the Legacy text control with the Word 2003 controls. 
 
Under Situation 2, you must use only the Word 2007 controls and cannot also use the Legacy 
controls or the Word 2010 checkbox in the same WEQ. None of the current methods for 
electronically extracting data from WEQs that are discussed later in this document will 
extract data from Word 2010 controls, and none of the methods will extract data from both 
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Legacy and Word 2007 controls at the same time.5 Further, there are no Word 2007 
checkbox controls; so, based on the conditions above, if you need one or more checkbox 
controls and you want to extract data electronically, you must use only the Legacy controls. 
Similarly, if you want to restrict the type of data that a respondent can enter in text control, 
you must use only the Legacy controls. 

 
You can use the Word 2010 checkbox if:  

 You do NOT want to electronically extract responses from the WEQs, AND 

 NO respondents will be using Word 2007 or earlier, 

As described above, none of the current methods for electronically extracting data from 
WEQs that are discussed later in this document will extract data from Word 2010 controls, 
and respondents using Word 2007 or earlier will not be able to check the Word 2010 
checkbox. 
 

Password-Protecting the Document for Use by Respondents 

Before sending a form to respondents, the questionnaire designer should protect the document 
with a password so that respondents can check checkboxes and select drop-down items and 
cannot modify the questionnaire other than answering questions. If the file is not “protected” as a 
form (with or without a password), respondents will not be able to check checkboxes or select 
drop-down responses. A password is not required but is highly recommended to keep 
respondents from deliberately remove the protection. 
 
To password-protect the document, click the “Protect Document” button (Word 2007) or the 
“Restrict Editing” button (Word 2010) in the Developer tab of the Word ribbon or and a menu 
will appear to the right. See Figure 4. Then check the box “Allow only this type of editing in the 
document:” and select “Filling in forms” from the drop-down menu. Then click the button 
labeled “Yes, Start Enforcing Protection” and enter a password that a respondent is unlikely to 
figure out. Record the password for future reference. 
 
To remove a password from a password-protected document, open the document and click the 
“Protect Document” or “Restrict Editing” icon on the Word ribbon and a menu will appear on 
the right. Click the Stop Protection button, enter the password, and click OK. IMPORTANT: 
Removing and then re-applying a password to a document whose controls have already been 
filled-in may erase the data in the controls. You can remove the protection from a filled-in form, 
but do not re-apply a password unless you want to erase the form data.  
 
 
  

                                                 

 
5 A macro or other method that can export Word 2010 checkbox control data and/or that can extract data from 
multiple Word versions simultaneously could be developed in the future. Please check with the GAO Survey Group 
for the latest methods for extracting data from WEQs. 
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Figure 4. Password protection menu before and after making selections. 

a. Before b. After  

 
 

Technical Tips 

1. General tips 

a. Use either Legacy controls or Word 2007 controls. Based on reasoning 
described elsewhere in this document, it is recommended that you use either 
Legacy controls or Word 2007 controls but not both in a single WEQ. If you use 
both types of controls in one WEQ, it is highly recommended that you test your 
process for exporting data and combining the data to ensure the process works as 
intended before fielding your questionnaire.  

b. Don’t use macros. GAO staff should not use macros (embedded within the 
controls or elsewhere in the Word document) in most WEQs used as 
questionnaires. Due to security concerns some respondents will not be willing or 
able to allow macros to operate on their computers and because the macro may 
not perform as expected on the respondent’s computer. If you must use macros, 
test the functionality extensively to ensure you will be able to collect the data as 
intended. On the other hand, macros are acceptable and may be very helpful for 
data collection instruments completed by GAO staff. 

c. Inserted hyperlinks may not work. In WEQs saved as either .doc or .docx files, 
you can insert hyperlinks to external webpages or documents (or even another 
page in the questionnaire such as an appendix), but the hyperlink might not work 
when the document is password-protected. To ensure all respondents will be able 
to access an external file you have hyperlinked, you should provide not only the 
hyperlink but also spell out the full hyperlinked address so that respondents can 
type it into a web browser (e.g., “Control-click here” or type the following in your 
browser’s address bar: http://www.fema.gov/pdf/emergency/nrf/nrf-core.pdf  to 
download the National Response Framework, if desired.”) 
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d. During development, it may be helpful to temporarily apply protection to test 
functionality by following the procedures for protecting the document presented 
elsewhere in this document but clicking “Yes, Start Enforcing Protection” and 
then clicking OK without entering a password. Click “Stop protection” to end 
temporary protection. 

e. In Word 2007 (and possibly in Word 2010 under VDI), do not insert anything in a 
footnote that you plan to remove before fielding (e.g., the word “Draft”) because 
problems with Word in DM sometimes make it difficult to remove text from 
footnotes. It is safest to insert such text in the header rather than the footer.  

2. Control considerations 

a. Do not embed controls in Word text boxes. Legacy controls cannot be 
embedded within text boxes. Word 2007/2010 controls can be embedded within 
text boxes but respondents cannot enter a response in them. There are advantages 
to adding borders around questions and response options, as a text box does, but 
to do so, embed the controls in table cells with visible borders rather than in text 
boxes (see more below). 

b. Embedding an open-ended text control in a table cell with a visible border will 
make the response area more salient to a respondent than the same text control 
appearing near text without a border and may reduce the number of respondents 
who accidentally skip a question. This is especially true if the WEQ is printed and 
filled in before being completed electronically and/or when shading has not been 
applied and the control itself is not visible. 

c. Consider adding empty space within a response area (or within the same table 
cell) under a text control for questions you hope to get long answers to. A single 
text control will occupy no more than a single line, and adding space below the 
control increases the size of the visible response area. This can be beneficial in at 
least two ways. First, increasing the size of the box beyond a single line presents a 
visual cue to the respondent that we are expecting more text than would fit on a 
single line (and therefore encourages longer and more complete responses). 
Second, if the WEQ is printed and completed by some respondents on paper 
before transferring the answer to the electronic version or returning the paper 
document by mail, the extra space will provide the respondent room to write the 
answer in the response box. See Figure 5 below. 
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Figure 5. Examples of single-line and multi-line response boxes embedded within table cells. 

 
 

d. Checkboxes or drop-down controls in lieu of radio buttons. Radio buttons are 
a common and useful feature in web and other electronic questionnaires, but they 
are only included in Word as an Active X control, but Active X is not 
recommended for most GAO WEQs. If you want respondents to select only one 
of several responses (the primary value of radio buttons), then the usual method in 
a WEQ is to use checkboxes, with one checkbox for each response option and 
explicit instructions to check only one box. The downside of this method is that 
there is nothing stopping the respondent from checking more than one checkbox 
for a single question. 

i. An alternative to the checkbox method is to use the drop-down (or combo 
box) control. The advantage of a drop-down control is that you can restrict 
respondents to selecting only one response (similar to the function of a 
radio button). However, a disadvantage of the drop-down control is that 
the response options are not visible on the document until the respondent 
clicks in the box, and therefore the response options are not visible on a 
printed version of the WEQ, which may significantly reduce the reliability 
of responses collected through such previously-printed WEQs. If you 
expect some respondents to print out the WEQ before completing it 
electronically -- for example to distribute the questionnaire to multiple 
team members before entering their responses in a single electronic 
response -- then using the checkbox method is likely to result in more 
reliable responses than using the drop-down or combo box controls.  

e. Prepopulate the first response option of drop-down and combo box controls 
with “blank” text. For drop-down controls and combo boxes, consider making 
the first/top response option a blank (i.e., prepopulate the first option as “  ” rather 
than as “Select One” or a substantive answer such as “Yes”, etc.) so that 
respondents will quickly recognize that they have not yet answered the question 
and will not accidentally skip it. Do so by entering spaces as a response option 
and making that the first response option. 

f. It is possible to restrict the type of data that a respondent can enter in a Legacy 
text control (e.g., you can restrict the control to accept only digits), but not in the 
Word 2007 text control. To do so in the Legacy control, insert the control then 
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open the control’s options and in the “Type” box select the type of data you want 
the control to accept, then click “OK.” However, realize that limiting the type of 
data to anything other than “regular text” will make it impossible for respondents 
to enter explanatory text as well. If you restrict a control’s content or format, 
consider adding a text control below the question for any additional comments the 
respondent might want to add for that question.  

3. WEQ page formatting suggestions 
 

a. Optimize your table cells for text controls. By default, when a respondent 
enters text in an open-ended control that is embedded within a table cell, the cell 
automatically expands horizontally (not just vertically, which is desired). That 
expansion may push text off the visible page, or if the table has more than one 
column, it may shrink the other columns, making text or controls in those cells 
unusable to respondents. To avoid this possibility when you are using controls 
within table cells, you should change the default behavior to make sure that the 
table cells will not resize horizontally automatically. To do so, highlight the table, 
right click inside the table, click Table Properties, click Options, then uncheck the 
box labeled “Automatically resize to fit contents”, and click OK. The table cells 
will still expand vertically (wrapping text) as the respondent enters text wider than 
the table column. To save time, it is best to do this for the first table cell you enter 
in a questionnaire and then copy that cell wherever needed (rather than creating 
all the cells you need and then changing each one manually). 

b. Leave empty lines at the bottom of pages that use open-ended text controls. 
Consider leaving several empty lines at the bottom of pages that use open-ended 
text controls that will expand vertically as the respondent types because as the 
boxes expand, any text or questions below them will be pushed down the page 
and eventually onto the next page, possibly destroying vertical formatting, 
splitting questions from instructions or response options from questions, etc. You 
can include empty space by inserting blank rows (manual returns), but a better 
method is by inserting a page break below the last open-ended text field. Using 
the latter method ensures that blank rows are not moved to the next page as the 
open-ended text fields are filled-in. Ensuring extra space at the bottom of pages 
may sometimes lead to large areas of empty space on a page, but this is not 
noticeable to respondents when completing the questionnaire on the computer and 
is probably a minimal concern for respondents who may print the questionnaire 
before filling it in. 

c. Insert tiny controls to ensure information is not accidentally skipped. If 
respondents navigate through a WEQ using the tab key, Word skips between the 
controls. If there are large sets of text without controls (e.g., most of the 
instructions on the first page of a WEQ, a page with key definitions), respondents 
will accidentally skip that text and may never realize it exists and that they have 
missed something important. Inserting tiny controls within those instructions will 
help ensure key information is not accidentally skipped when respondents 
navigate through the questionnaire.  
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i. Insert tiny, almost-invisible controls immediately above such instructions 
(e.g., insert a checkbox control, select it, and change its font size to 1pt). 
This will ensure that when respondents tab after answering a question they 
will tab to the start of any instructions they would otherwise tab past. 
Insert such controls within long sets of instructions or anywhere text may 
be skipped. This is also important for instructions on the first page of the 
document because respondents may return to the first page after 
completing the last question in the questionnaire or for other reasons. 
There is a tiny control inserted directly below this paragraph as an 
example of the size of the box relative to the text around it. 

 
ii. Inserting the control in the right margin may make the control less 

noticeable to respondents than if it were in the left margin, depending on 
the layout of text near it. (For example, there is a tiny control in the right 
margin in the line immediately above item “a” on the previous page that 
you may not have noticed.) However, note that it is easier to accidentally 
delete the tiny controls on the right when changing the document, so check 
the questionnaire carefully before fielding to ensure all controls remain. 

iii. You can use any type of control for this purpose (checkbox, etc.), though 
checkboxes are inherently smaller than the other types of controls so may 
be the least distracting choice.  

4. Preparation just before fielding 

a. Pick a filename meaningful to the respondents. Carefully consider the filename 
to use for the copy of the questionnaire that you will send to respondents. The 
filename should make sense to the respondents when they see it in their folder two 
weeks after they receive and save it. Including the abbreviation “GAO” and the 
word “survey” or “questionnaire” in the filename will probably be helpful, in 
addition to a short description of the topic (e.g., “GAO survey on strategic 
planning.docx”). 

b. Remove comments and tracked changes. Ensure that all comments and tracked 
changes have been removed from the file before sending to the respondent. Word 
sometimes does not display comments and other changes in “Print Layout View” 
so you should check the document using “Web layout View” as well. 

c. Accept all changes in “track changes” and save “final” not “show markup.” 

d. Ensure that all controls are present rather than just appearing so.  

i. Checkboxes: Ensure that all checkboxes are really checkbox controls  
that can be checked by respondents rather than graphic checkboxes  that 
are useful for mailed questionnaires but that are not really controls that can 
be checked by respondents in a WEQ.  

ii. Text controls: Ensure that response areas or table cells that should have 
text controls actually do have the controls in them. When control shading 
is turned off or when some types of background highlighting are used, it 
may be difficult to notice that there is no control where there should be.  
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iii. Testing: Make a copy of the document, temporarily protect it, then test 
every control by checking checkboxes, typing in text controls, and 
manipulating other controls. Simply tabbing between controls is 
insufficient because you may simply tab past non-controls without 
noticing something was skipped. 

 

Tips for Sending WEQs to Respondents 

1. Send WEQs in individual not group emails. Generally, it is best to send the WEQ 
documents by email as an attachment to each respondent individually (i.e., only one 
respondent per email). Sending emails to all respondents in the same email divulges to all 
respondents who the other respondents are, which is poor practice and could lead to a 
violation of confidentiality, especially if the respondent accidentally uses “reply all” to 
return a completed questionnaire or to ask a sensitive question. Such a scenario with 
classified WEQs collected through SIPRnet email could also lead to a security violation. 
Also, sending emails to many respondents in the same email using the blind courtesy 
copy (“bcc”) option may result in some email servers rejecting the email as spam. 

2. Use a cover “letter” email. Best practice is to include a cover “letter” in the same email 
as the questionnaire, either embedded as text in the email or as another email attachment. 
See the ARM guidance on Letters, E-mail messages, and Introductions for Mail and 
Electronic Questionnaires. 

3.  Include key information from the cover email on the first page of the WEQ. 
Including key information from the cover email (e.g., questionnaire purpose and 
motivational or confidentiality text) can be important because the WEQ may be printed 
and distributed to staff who do not have access to the cover letter/email. 

4. Consider automating the process of sending the WEQs by email if you have a large 
number of respondents,. Unfortunately, Word’s Mail Merge feature does not allow 
attachments to the emails it produces, so Word mail merge is not appropriate for sending 
WEQs as attachments.6 SAS code may be available that will send the documents to 
recipients as email attachments through Outlook. For some surveys, ISTS may be able to 
send a large number of customized emails for you. Contact the ARM Survey Group for 
current procedures for sending mass emails with questionnaire attachments and/or for 
current SAS code. 
 

                                                 

 
6 If for some reason you must send a cover email that includes a link to download the WEQ from a location on 
GAO’s server then you can use Word’s Mail Merge feature or can use QPL to send the cover email. Either way, you 
will need to post the questionnaire on GAO’s publically-accessible server so respondents can download it. However, 
requiring respondents to download a copy of a questionnaire from a link is not best practice for distributing 
questionnaires and should be avoided if possible. 
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Tips for Extracting Data From Completed WEQs 

Contact the ARM Survey Group for the current procedures for extracting data from WEQs. Note 
that if you use the first three methods below to electronically extract data, from checkboxes for 
multiple choice answers (i.e., for Question 1, one checkbox for “Yes”, one checkbox for “No”, 
etc.) the result will be one variable in your dataset for each checkbox rather than one variable for 
each question (i.e., one variable for “Question 1 - Yes”, a separate variable for “Question 1 - 
No”, etc. rather than one “Question 1” variable with a “Yes” level, a “No” level, etc.). If that is 
how you plan to analyze the data then there is no problem. But if you need individual variables 
for each question, you have at least the following options:7 

1. Extract the data electronically using one of the first three extraction methods below, then 
recode the multiple variables per question into multiple levels of a single question 
variable (using SAS or other software). 

2. Manually enter the data using the last extraction method below, recording checked 
responses as one of multiple levels of a single variable (i.e., the “Yes” checkbox for 
Question 1is manually entered as level “Yes” for the “Question 1” variable, etc.). 

3. Design the questionnaire to use Word drop-down controls instead of checkboxes for 
multiple choice questions, then extract the data electronically using one of the first three 
extraction methods below.  

4. Program the questionnaire in QPL or as a pdf form rather than as a WEQ and use radio 
buttons instead of checkboxes for multiple choice questions to save the responses as 
multiple levels of a single variable.  

As of the publication of this document, there are four main methods used at GAO for extracting 
the data from completed WEQs into a spreadsheet or database for analysis. It is highly 
recommended that you test your preferred method on an early version of your questionnaire with 
at least one of each control type you plan to use to ensure extraction will work as you expect 
before you invest time in adding all controls.  All four methods work with the Legacy controls; 
only the first method works with Word 2007 controls. Only the last method (manual data entry) 
works with the Word 2010 checkbox control. 

1. Use a Word/Visual Basic macro to export Legacy or Word 2007 responses from 
multiple questionnaires. A process to automatically export data from multiple Word 
files into a single comma-delimited file using Visual Basic is an option and the macros 
themselves are available by contacting ARM. The comma-delimited data can then be 
imported into any data processing software. This method is appropriate for sensitive or 
classified information. This method works for Word Legacy and 2007 controls. However, 
as of the date of this document, each macro can only export data from either Legacy or 
2007 controls; a single macro cannot export data from both types of controls in the same 
step. Special characters (e.g., carriage returns, tabs, bullets) in WEQ responses remain in 

                                                 

 
7 You may wish to consider the number of multiple choice questions, the number of response options, the variety of 
response options (i.e., all questions use Yes/No, or a variety of different scales are used), the amount of time 
available before fielding the questionnaire, and the amount of time before analyses must be completed after data 
collection ends as you choose the most appropriate option. 
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the resulting delimited-text files and create errors when the data are imported into 
analysis software and so they must be removed from each WEQ prior to executing the 
macro or removed from the resulting delimited text file prior to importing into analysis 
software. 

2. Export responses from Legacy controls from individual questionnaires as comma-
delimited text data and manually import into Excel. Responses from individual WEQs 
can be saved as comma-delimited text data and then imported into Excel using the “Save 
form data as delimited text file” Word option. As in the method above, special characters 
(e.g., carriage returns, tabs, bullets) must be removed from each WEQ prior to export or 
removed from each delimited text file prior to importing into Excel. This method only 
works for Legacy controls. This method is appropriate for sensitive or classified 
information. 

3. Import delimited text data from Legacy controls using SAS. Text delimited data can 
be exported from individual WEQs without manually removing special characters and 
then, using SAS syntax, automatically cleaned of special characters and imported into 
SAS. This method requires exporting text delimited data from individual WEQs before 
running the SAS program. This method is probably most appropriate when there are a 
very large number of WEQs (dozens to hundreds) that have many open-ended responses, 
which would otherwise require much effort to manually remove special characters before 
exporting using the methods above. This method requires access to and familiarity with 
the statistical program SAS. This method only works for Legacy controls. This method is 
appropriate for sensitive or classified information. 

4. Manually enter the responses in a database. Responses can be manually typed (or 
copied and pasted) into a spreadsheet or database by GAO staff or by a contractor that 
GAO uses for this type of task. Using the contractor is not an option for classified 
surveys. This method works on all types of controls because the questionnaires are 
printed before manual data entry. This method may be most useful when a WEQ is sent 
to respondents for completion electronically but the respondents print the completed 
documents and mail them back to GAO. It is also the only option currently available for 
transferring Word 2010 checkbox data to an electronic database. 
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Appendix I - Checklist of Reminders for Creating WEQs 

During development: 

1. Develop the questionnaire according to general survey research best practices, including 
preliminary design, peer review, and cognitive pretesting, as needed. 

2. Early in development, if you plan to extract data from the questionnaires, test the data 
extraction process you plan to use on at least one of each type of control to ensure that 
you will be able to get all the data out of the questionnaire as hoped. 

a. If you will want to extract data from Legacy controls using ARM’s Microsoft 
Access tool or any other method that requires unique bookmark names for each 
control, ensure there is a unique bookmark name for each control.8 

3. Ensure there are controls everywhere there should be. 

4. Insert tiny controls at the start of -- and within long sections of -- text/instructions as 
necessary to ensure the text is not skipped as respondents tab through the questionnaire. 

Just before fielding: 

5. If you have embedded open-ended text controls within table cells, check that the tables’ 
default to automatically resize horizontally is disabled and fix any that are not.  

6. Remove comments and tracked changes from the document. 

7. Ensure the “track changes” feature is turned off. 

8. Ensure “Design Mode” is turned off. (You cannot password-protect a document that is in 
design mode.) 

9. Remove the word “DRAFT” and any other GAO-internal/administrative text that a 
respondent does not need to see from the header and footer (or watermark) of the 
document. 

10. If not already done, save the non-password-protected WEQ document in DM. This is 
your archive copy and may be used for workpaper and report documentation and for 
copying into the appendix of a report.  

11. Save the WEQ document outside DM, possibly using the filename you would like 
respondents to see when they receive the attachment (e.g., “GAO Survey on XYZ.docx”). 

12. Password-protect the WEQ document outside DM using the “Protect Document” process 
described above. 

13. Save the password-protected WEQ document again. (If you did not already save the file 
using the filename you want respondents to see when they receive the file, do so now.) 

14. Conduct usability testing to ensure that all features work as expected. Preferably, conduct 
testing on a computer and screen combination that is different from the one used to 

                                                 

 
8 This extraction method has not been used recently at GAO and is not discussed in this document. Contact the 
Survey Group for details if you are interested in learning more about the method. 
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develop the questionnaire. This is especially important if you developed a Word 2010 
(VDI) document but some respondents may use Word 2007 or an earlier version.  

a. Check that the form can only be unprotected by using the password if the form is 
being used as a questionnaire (rather than a DCI completed by GAO staff). Ensure 
that all controls work as they should, that open-ended text wraps as expected in 
open-ended controls in table boxes, and that all instructions and questions are 
visible (and not skipped) as a respondent navigates through the questionnaire. 
Consider testing your planned data extraction process again on all questions 
before fielding. Revise the DM version as necessary and continue the process 
until the questionnaire is ready to be used. 
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Appendix II - Displaying the Developer Tab in the Word Ribbon 

Use the information in this appendix to display the Developer tab in the Word ribbon if it is not 
already visible. The instructions differ between Word 2007 and Word 2010 (VDI). 
 

In Word 2007: 

 Open Word 2007. 
 Click on the “Office” logo in the upper left. 
 Click the “Word options” button in the lower right of the pop-up menu. 
 Select “Popular” from the menu on the left (if not already selected). See Figure 6a. 
 Check the box for “Show Developer tab in ribbon.” 
 Click “OK.” 

 
Figure 6a. Word 2007’s Word Options screen. 

 

 

In Word 2010 (VDI): 

 Open Word 2010. 
 Click the “File” tab. 
 Click the “Options” button from the list. 
 Click the “Customize Ribbon” button from the list.  
 Check the box for “Developer” in the list box on the right. See Figure 6b. 
 Click “OK.” 
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Figure 6b. Word 2010’s Customize Ribbon selection box. 

 

 

The Developer tab will then be available in your ribbon. 

 


